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SECTION 1 -INTRODUCTION

1.1 Welcome

This manual provides instructions for the use of the Raychem ACS-30 Program Integrator utility software. The ACS-30 Program Integrator is a
utility used on Microsoft® Windows PCs that allows the user to easily set up ACS-30 circuit databases with the comfort of a larger display and
a keyboard as an input device. The Program Integrator is also able to transmit and receive circuit databases to and from the UIT2, making it
simple to create, backup, and modify ACS-30 circuit databases.

1.2 User Responsibilities

The performance, reliability and safety of your Chemelex heating cable system depends on proper design, selection and installation. The
RAYCHEM ACS-30 Program Integrator Utility will help you configure and update ACS-30 circuit databases, but it is only a tool. It assumes
that your input is accurate and that you will ensure that the uploaded configuration of the heating cable system is installed, maintained
and used as intended. The ACS-30 Program Integrator Utility should be used under supervision of a knowledgeable engineer to ensure it is
used appropriately.

The ACS-30 Program Integrato r must be used in conjunction with the ACS-30 Programming Guide (H58279 or H58692 for use
ACS-UIT2) and the appropriate Chemelex heating cable application design guide that pertains to your particular application.

1.3 Safety Warnings

There are important safety warnings shipped with Chemelex and follow them to reduce the risk of fire, shock or personal injury. If you have any
questions, contact your local representative or Chemelex directly.

1.4 License Agreement
Chemelex
ACS-30 Program Integrator Software License Agreement

PLEASE REVIEW THE FOLLOWING TERMS AND CONDITIONS OF THIS SOFTWARE LICENSE AGREEMENT (THE "AGREEMENT") CAREFULLY.

THIS IS A LEGAL AGREEMENT BETWEEN YOU, THE END USER, AND CHEMELEX. THE TERMS OF THIS AGREEMENT GOVERN YOUR USE OF

THE ACS-30 PROGRAM INTEGRATOR PROGRAM, AND ANY ACCOMPANYING WRITTEN MATERIALS OR FILES. BY INSTALLING, ACCESSING, OR
OTHERWISE USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ AND UNDERSTOOD ALL OF THE TERMS AND CONDITIONS OF
THE AGREEMENT AND ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT.

IF YOU DO NOT ACCEPT ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT DO NOT INSTALL, ACCESS, OR USE THE SOFTWARE. IF
YOU ACQUIRED THE SOFTWARE ON TANGIBLE MEDIA (E.G., CD-ROM) WITHOUT AN OPPORTUNITY TO REVIEW THIS AGREEMENT AND YOU DO
NOT ACCEPT THIS AGREEMENT, (1) DO NOT INSTALL OR USE THE SOFTWARE; AND (2) DESTROY OR RETURN THE SOFTWARE AND ALL OTHER
ITEMS RECEIVED WITH THE DISK (INCLUDING WRITTEN MATERIALS, PACKAGING, ETC.) TO THE PLACE WHERE YOU OBTAINED THEM, WITHIN
THIRTY (30) DAYS OF RECEIPT. THIS SOFTWARE IS BEING PROVIDED FREE OF CHARGE AT THE DISCRETION OF CHEMELEX.
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GRANT OF LICENSE. Subject to the terms and conditions of this Agreement, Chemelex grants to you a non-exclusive, revocable,
limited license to use the Software

OWNERSHIP OF SOFTWARE; LICENSE FEE. The Software is licensed, not sold, to you for use only under the terms and conditions of this
Agreement. Your license confers no title or ownership of the Software and should not be construed as a sale of any rights in the Software.
Chemelex shall retain all and sole right, title, and interest, including the copyright, in and to the Software. Chemelex reserves any rights not
expressly granted herein.

RESTRICTIONS. The Software is protected by law, including without limitation the copyright laws of the United States and other countries and
by international treaty provisions. The structure, organization and code of the Software are valuable trade secrets and confidential information
of Chemelex. You agree not to modify, alter, merge, adapt, duplicate, distribute, translate, decompile, disassemble, reverse engineer, create
derivative works. The Software is licensed to you. In no event may you transfer, sell, sublicense, rent, assign or transfer rights, or lease the
Software without the prior written consent of Chemelex. You agree to use reasonable efforts to protect against the unauthorized use of the
Software. You agree not to remove, disable or circumvent any proprietary notices or labels contained on or within the Software.

SUBMISSIONS. Chemelex welcomes your comments, feedback, and suggestions about how to improve the Software, or about any "bugs,"
defects, or seemingly incorrect or anomalous results discovered or produced through the use of the Software. However, you agree that

by sending Chemelex any idea, suggestion, information, know-how, material, data, or any other content (collectively, "Submissions"), such
Submissions become the property of Chemelex and that Chemelex may, at its option, use any Submission (or any modification or derivative
thereof) without any obligation to you. Should you have any questions or comments concerning the Software, this Agreement, or if you desire
to contact Chemelex for any reason, please write to:

Chemelex

307 Constitution Dr.

Menlo Park, CA 94025-1164
USA.
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TERMINATION. This Agreement is effective until terminated. You may terminate the license at any time by destroying the Software (including
any and all related documentation). This license will terminate automatically without notice from Chemelex if you fail to comply with any
provision of this Agreement. Upon termination of this Agreement for any reason, you agree to destroy all copies of the Software (including all
written materials or files, if any). Chemelex may terminate this license at its discretion with written reasonable notice.

DISCLAIMER OF WARRANTY. THE SOFTWARE (INCLUDING ANY ACCOMPANYING WRITTEN MATERIALS OR FILES) ARE PROVIDED “AS

IS" AND “AS AVAILABLE” WITHOUT WARRANTY, EXPRESS OR IMPLIED, OF ANY KIND, INCLUDING WITHOUT LIMITATION, WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE (EVEN IF CHEMELEX HAS BEEN ADVISED OF SUCH PURPOSE). NO ORAL OR
WRITTEN INFORMATION OR ADVICE GIVEN BY CHEMELEX ORITS DEALERS, DISTRIBUTORS, OR AGENTS, SHALL CREATE SUCH A WARRANTY.
CHEMELEX DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT THE SOFTWARE IS VIRUS-FREE, OR THAT PROGRAM
DEFECTS WILL BE CORRECTED.

It is assumed that the user of the Software is expert in the engineering design of heat-tracing systems. Chemelex has not verified the

results produced by the Software for all conceivable design or analysis cases, application scenarios, or system settings. You must judge the
reasonableness of the results obtained by using your engineering expertise, and should independently evaluate the Software results before
taking any action in reliance thereon. The entire risk as to the quality, accuracy, adequacy, completeness, correctness, suitability, and validity of
the Software programs results rests with you.

LIMITATION OF LIABILITY. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IN NO
EVENT SHALL CHEMELEX; ITS AFFILIATES, DIRECTORS, OFFICERS, SHAREHOLDERS, EMPLOYEES OR OTHER REPRESENTATIVES BE LIABLE

FOR DAMAGES OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY LOSS, DAMAGE, OR DELAY, OR FOR ANY LOST PROFITS, LOSS OF USE,
INTERRUPTION OF BUSINESS, OR FOR ANY COMPENSATORY, SPECIAL, INCIDENTAL, CONSEQUENTIAL, INDIRECT DAMAGES (HOWEVER
ARISING, INCLUDING NEGLIGENCE) OF ANY KIND ARISING OUT OF OR IN CONNECTION WITH THE USE OF, OR THE INABILITY TO USE, THE
SOFTWARE OR THIS AGREEMENT (EVEN IF CHEMELEX HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES). FURTHER, IN NO EVENT
SHALL CHEMELEX, ITS AFFILIATES, DIRECTORS, OFFICERS, SHAREHOLDERS, EMPLOYEES OR OTHER REPRESENTATIVES BE LIABLE TO YOU IN
AN AMOUNT GREATER THAN THE AMOUNT ACTUALLY PAID BY YOU, IF ANY, FOR THE SOFTWARE. YOU FURTHER AGREE THAT REGARDLESS OF
ANY STATUTE OR LAW TO THE CONTRARY, ANY CLAIM OR CAUSE OF ACTION ARISING OUT OF OR RELATED TO USE OF THE SOFTWARE OR THE
TERMS AND CONDITIONS MUST BE FILED WITHIN ONE (1) YEAR AFTER SUCH CLAIM OR CAUSE OF ACTION AROSE OR BE FOREVER BARRED.

RAYCHEM-AR-H58325-ACS30programintegrator-EN-2504 chemelex.com | 5



INDEMNITY. To the extent allowed under applicable federal and state law, you agree to indemnify and hold Chemele, its parents, subsidiaries,
affiliates, officers, employees, sponsors and partners harmless from any claim, loss, cost, expense, demand, or damage, including reasonable
attorneys' fees, arising directly or indirectly out of (a) your use of, or inability to use, the Software, (b) your activities in connection therewith, or
(c) your breach of this Agreement or violation of the rights of any other party.

COMPLETE AGREEMENT; MODIFICATION IN WRITING. This Agreement constitutes the sole and complete understanding between the
parties with respect to the Software and its use, and may not be varied except by a writing signed by an officer of Chemelex. You agree that you
may not rely on any representations concerning the Software to the extent they vary from this Agreement, and such representations, if any, will
neither add to nor vary the terms of this Agreement.

CHOICE OF LAWS; JURISDICTION. This Agreement is governed by the laws of the State of California and the United States, including U.S.
Copyright Laws, regardless of the laws that might otherwise govern under applicable principles of conflicts of law. The parties hereby submit to
the jurisdiction of, and waive any jurisdiction and venue objections against, the state and federal courts sitting in the State of California in any
litigation arising under this Agreement.

EXPORT LAWS. If the Software is for use outside of the United States, you agree to comply fully with all relevant regulations of the United
States Department of Commerce and with the United States Export Administration Act to ensure that the Software is not exported in violation
of United States law. You agree that the Software will not be exported, shipped, transmitted, or re-exported in violation of any applicable law
or regulation, including without limitation Export Administration regulations issued by the U.S. Department of Commerce, or any other export
laws, restrictions or regulations (collectively, the “Export Laws"). In addition, if the Software is identified as an export controlled item under

the Export Laws, you represent and warrant that you are not a citizen, or otherwise located within, an embargoed nation (including without
limitation Iran, Iraq, Syria, Sudan, Libya, Cuba, North Korea, and Serbia) and that you are not otherwise prohibited under the Export Laws from
receiving the Software. All rights to use the Software are granted on condition that such rights are forfeited if you fail to comply with the terms
of this Agreement. You agree to indemnify Chemelex and assume all financial responsibility for any losses it may suffer if you do not comply
with the terms of this Section 11.

UNITED STATES GOVERNMENT RESTRICTED RIGHTS. User acknowledges that the Software has been developed at private expense and is
provided with “Restricted Rights.” Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (b) (3)
and paragraph (c) of the Rights in Technical Data clause at 48 C.F.R. 252.227-7013, or subparagraphs (c)(1) and (2) of the Commercial Computer
Software - Restricted Rights clause at 48 C.F.R. 52.227-19, as applicable. This provision applies to the Software acquired directly or indirectly by
or on behalf of any government. The Software is a commercial product, and was developed entirely at private expense and without the use of
any government funds. Any use, modification, reproduction, release, performance, display, or disclosure of the Software by any government
shall be governed solely by the terms of this Agreement and shall be prohibited except to the extent expressly permitted by the terms of this
Agreement, and no license to the Software is granted to any government requiring different terms.
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ASSIGNMENT. You may neither assign any right nor delegate any obligation under this Agreement and attempted assignment or delegation
shall be void. Chemelex may freely assign this Agreement and its rights and obligations hereunder to any third party.

INVALID PROVISIONS. If any of the provisions of this provisions Agreement are invalid under any applicable statute or rule of law, the parties
nevertheless agree that the court should endeavor to give effect to the parties’ intentions as reflected in the provision and all other provisions
remain in full force and effect.

WAIVER. No failure or delay of Chemelex in exercising or enforcing any right or provision of this Agreement shall constitute a waiver of

such right or provision, or any other right or provision hereunder. Furthermore, any waiver by Chemelex of any right or provision of this
Agreement shall not be construed as, or constitute, a continuing waiver of such right or provision, or waiver of any other right or provision of
this Agreement.

HEADINGS. The section titles in this Agreement are for convenience only.

SURVIVABILITY. You agree that the terms and conditions of this Agreement shall survive any termination of this Agreement and your rights to
use the Software.

ACKNOWLEDGEMENT. You hereby acknowledge that you have read this Agreement, understand it and agree to be bound by its terms and
conditions, and that this Agreement may be executed by electronic signature, including (without limitation) by clicking

"TAGREE."

1.5 Technical Support

For technical support, contact your local Chemelex Representative or technical support group at:

Tel (800) 545-6258

Tel (650) 216-1526

info@chemelex.com

1.6 System Requirements
The following equipment will be necessary to use the ACS-30 Program Integrator:

+ A PentiumIII - 500MHz or faster (Recommended), Pentium II - 300 MHz (Minimum) IBM compatible personal computer
+ A hard disk with at least 1 Megabyte of free space

+ 256 MB of RAM (Recommended), 128 MB of RAM (Minimum)

+ A mouse or other compatible pointing device

+ Screen resolution of at least 800 x 600

+ Microsoft Windows Vista, Windows XP Pro, Windows XP Home, or Windows 2000

+ .NET Framework version 2.5

+ RS-232/485 Connectivity or Ethernet using a crossover cable
Optional:

+ USB Flash Drive: 128 MB, USB 1.1 or higher.
+ USB Port supporting USB 1.1 or higher
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SECTION 2 - ACS-30 PROGRAM INTEGRATOR UTILITY

2.1 Basic Assumptions

This user guide assumes that the user is familiar with the Microsoft Windows environment. This includes the knowledge of how to launch an
application, manipulate files, use menus and window boxes, and using a mouse or other comparable pointing device.

2.2 Installing ACS-30 Program Integrator

1. 1. Double-click Setup.exe to run the ACS-30 Program Integrator installation.
2. 2. Follow the steps on the screen to complete installation.

2.3 Starting the ACS-30 Program Integrator
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After installation, a shortcut will be created both on the desktop and in the Start Menu. To start the program, either double-click the icon on the
desktop or click Start > Programs > Chemelex > ACS-30 Program Integrator > ACS-30 Program integrator.

The program will launch with an empty database file. To open an existing database, click File > Open. An ACS-30 database is stored as an
Extensible Markup Language (XML) file which consists of a list of circuits and all of their parameters as seen on the ACS-UIT2.
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2.4 Menu Bar

The menu bar options are organized for creating and opening databases, uploading and downloading databases to and from the
ACS-30-UIT2, printing database reports, and other useful functions.

[ Integratore sample circuitsxml - ACS-30 Program Integrator

Edit System Site Help

D Mode General | Temp Values | RTDs | Alams | G.F. | Maint. |

Cooling tower 1 Pipe Freeze RTDs

Cooling tower 2 Pipe Freeze Address Number Mode

Cooling tower 3 Pipe Freeze | s

Hot water West wing atakis local |7 «||1 ~||Ambient Control

HWAT East wing HWAT RTDB (7 v|(2  ](Lne Montor

Lobby floor 1 Floor Heating I

Lobby floor 2 Fioor Heating RTDC [ w]( -] |Beemal Conro

floor ambient ovemide Unassigned

ID 24 Unassigned

ID 25 Unassigned
71 Fire Sprinklers Pipe Freeze
TM-A 1D TM-A Temp Monitor
TM-B  IDTM-B Temp Monitor
™ML IDTML Temp Monitor
TM-D IDTM-D Temp Monitor
TM-E IDTM-E Temp Monitor

[] Hide Unassigned Circuts
€910 Circuit 7-1: Fire Sprinklers

Figure 1 Main Window: Menu Bar

2.4.1 FILE

This menu allows you to open, save, and create new database files. Other functions include transmitting or receiving data from the
ACS-30-UIT2 and printing database reports.

New - Clicking this option clears the current database and lets you start with a brand new blank circuit database.
Open - This option will launch the Open File window which will allow you to choose an existing database to view and edit.

Save - This option will save the current database if it is being modified. If the database is new and has never been saved before,
clicking on this option will launch the Save File As window.

Save As - This option will save the current database allowing you to select location and rename the file.

Import and Export... - This option will launch the Import and Export utility to send and receive databases to and from the
ACS-30-UIT2. This topic will be discussed in detail in Section 6.

Page Setup - This option allows you to adjust paper size and orientation.
Print Preview - This option will show you a preview of the printed system circuit summary report before printing it.

Print - This option will launch the Print window allowing you to select the printer and adjust the printer settings before the system circuit
summary is sent to the printer.

Exit - This option will terminate the ACS-30 Program Integrator.
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2.4.2 EDIT
This menu gives you the option to do basic copy and pasting, along with other functions which include editing the Device List.
Copy - This function places the current circuit in the clipboard which can then be pasted onto any unassigned circuit.

Paste - This function pastes all of the parameters of the circuit on the clipboard (except RTDs and ID) into any unassigned circuit selected on
the Circuit List panel.

Unassign - Clicking this option will unassign each selected circuit on the Circuit List panel.
Select All - Clicking this option will select all Circuits in the Circuit List panel.

Devices - This function launches the Device List where you can add, edit or remove devices from the list.

2.4.3 SYSTEM

Temp Units - This menu allows you to choose which temperature units will be displayed in the program. A check mark will be placed adjacent
to the active temperature unit.

Stagger Start - will sequentially power the circuits in each ACS-PCM-5 to reduce the overall load during start-up.

2.4.4 SITE

This menu allows you to edit the Site Documentation. Clicking on Documentation under this menu will launch the Site Documentation window
where information such as the site supervisor and contact numbers can be placed.

2.4.5 HELP

This menu contains the version information for the ACS-30 Program Integrator and a hyper link to the ACS-30 product page containing this
user manual. For further information and all the ACS-30 literature please go to: Chemelex.com.
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SECTION 3 - CREATING THE ACS-30 CIRCUIT DATABASE

This section will go through the process to set up the heating cable system parameters and build the ACS-30 database. You should have a
summary of the heating cable system design available to enable you to input the control parameters. Consult the ACS-30 Programming Guide
(H58279 or H58692 for use ACS-UIT2) and the appropriate heating cable application design guide in setting up these parameters.

i e S &
aam rogram Integrator . L5 Untitled.xml .ilCSBDFmgwn]nﬁeg

File Edit System Site Help File Edit | System | Ste Help
Crout 1D Mode " Generdl | RTDs | Alams | Crot 1D TempUnits  » [ General [ Temp Values | RTDs [ Hams [G.F. [ Vokage | Mant. |
Circuit Options Stagger Start Martenance
o 12 D12 PowerCycle Stat e 601 (21 [¥] 24iv
Z ) 13 D13 Unassigned
Mode | Temp Monitor ' Circuit - 14 014 Unassigned Power Cycle interval

15 D15 Unassigned
21 0z Unassigned
22 D22 Unassigned
23 D23 Unassigned
24 D24 Unassigned
25 D25 Linassigned
71 D71 Unassigned

TMA  IDTHA Temp Monitor

TME IDTMB Temp Montor

== = (e ML IDTNEC Temp Monttor

Unassign Circuit Copy Circuit TMD IDTMD Ta Mol

THE IDTME Temp Montor

e Lt G Add/Remove Devices | <<-Click Here to Begin ] Fide Add/Remave Devices
I )| pem Cireuit1-2:101-1 )

Figure 2 Main Window and Circuit Parameter tabs: With and without circuits assigned.

The main window consists of a Circuit List to the left, and the Circuit Parameters on the right. Clicking on a Circuit on the Circuit List will bring
up the parameters of that circuit into the tabs on the right.

Below the Circuit List is a checkbox allowing you to hide the circuits whose Control Mode is set to Unassigned. This will make it easier to work
with active Circuits.

Below the Parameter tabs is a button labeled "Add/Remove Devices,” which is a shortcut to the same Device List under Edit | Devices. This
will launch a window box allowing you to edit the device in this ACS-30 setup. If no circuits have been assigned to the system “Start here” is
displayed to the right of the Add/Remove Device button.

3.1 Add/Remove Devices

This window allows you to create or edit the device list. Devices must be added to the list before heating cable circuit parameters can be set-up
in the program.

1. 1. Click on the Add/Remove Devices button on the main window.
2. 2.The Device List will appear. Click on the Add button.

pevice st

Address | Device | Add |
Removel

_ Cancel |

Figure 3 Device List
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3. The Add Device window appears

-
Add Device —

Device |[PCM -

Address

Can oK

l[mll[ ]I

Figure 4 Add Device Wingow

Device: This window allows you to set the device type:

Raychem CRM: The ACS-PCM-5 power control panel
Raychem C910: A single circuit C910 controller
Raychem RMM2: The remote temperature monitoring module.

Device Address: The following table lists the device addresses available for the devices:

Table 2.1 Available Device Addresses

Device Device Type Switch setting Device address
ACS-CRM Relay Output/RTD 1-99 1-99

Co10 Relay Output/RTD 1-99 1-99

RMM2 RTD 0-9 32-41

RMM2 RTD A-F 42-47

RAYCHEM-AR-H58325-ACS30programintegrator-EN-2504
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Select a Device and a Device Address then press OK to add this device and address to the list.

Figure 5 Device List with a PCM panel, C910-485 controller and a RMM2 temp module

4. Repeat as necessary to add additional devices
5. Click OK to finish
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3.2 Parameter Tabs

The Parameter Tabs are the heart of the program. All circuit settings can be configured with these tabs. All the heating cable application modes

and ACS-30 control parameters are described in the ACS-30 Programming Guide
(H58279 or H58692 for use ACS-UIT2).

3.2.1 GENERAL TAB

The General Tab is where all general settings reside.

st A posm e S e

File Edit System 5Site Help

Circutt 1D Mode | General |

1-1 1011 Unassigned Circuit Options

1-2 D 1-2 Unassigned D -ID 1T1 B o o o ]
1-3 ID1-3 Unassigned

4 D14 Unassigned Mode | Unassigned v| Crout [Enabled ~

1-5 D15 Unassigned

21 1021 Unassigned

22 D22 Unassigned

23 D23 Unassigned

24 D24 Unassigned

25 D25 Unassigned

71 1D 7-1 Unassigned

TM-A 1D TM-A Temp Monitor

TM-B  IDTM-B Temp Monitor

TMLC  IDTMLC Temp Monitor S —
TM-D D TM-D Temp Moritor | Unassign Circuit. | | Copy Circut |
TM-E IDTM-E Temp Monitor

[ Hide Unassigned Cincuits Add/Remove Devices

PCM Circuit1-1: 1D 1-1

Figure 6 General Tab
ID - This is the name assigned to the circuit for easy identification. A 40 character limit is placed on this field.

Mode - Clicking this will drop down a list of available heating cable application Control Modes for the ACS-30.
The available control modes include:

+ Unassign: Clears all circuit parameters

- Raychem HWAT: Hot Water Temperature Maintenance application

- Cable type

- Voltage

- Pipe type

- Ambient temperature
- Power factor

+ Frost Heave: Freezer Frost Heave Prevention application
+ Floor Heating: Floor Heating application

- Pipe Freeze: Pipe Freeze Protection application

+ Fuel Oil: Fuel Oil Flow Maintenance application

RAYCHEM-AR-H58325-ACS30programintegrator-EN-2504
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- Greasy Waste/FM: Greasy Waste and other flow maintenance applications with a temperature setpoint above 70 F.
+ Roof & Gutter: Roof and gutter de-icing

- Ambient Control
- Surface Temp control
- External Device Control

+ Snow Melting: Surface snow melting

- Ambient Control
- Surface Temp control
- External Device Control

+ Temp Monitor: The mode assigns up to four RTDs to monitor a critical point and set high/low temperature alarms. No circuit relays are
associated with this position

Note:

Changing control modes will enable and disable different options depending on which parameters are needed for that mode.
Changing from one mode to another will result in the loss of any previously entered data as the default values are loaded.

- Enabled Checkbox - This indicates if the circuit should be enabled or disabled.

+ Copy Circuit - This button launches the Copy Circuit utility that is similar to the one on the ACS-UIT2. This can be used instead of the Edit >
Copy method in the menu bar.

+ Unassign Circuit - Clicking on this button will unassign the current circuit. This has the same effect as changing the Mode to Unassigned.

- Temperature Control options - Once an application control mode is selected the temperature control method can be set to Ambient, Line
Sensing or PASC depending upon the application.

Enabled Checkbox - This indicates if the circuit should be enabled or disabled.

Copy Circuit - This button launches the Copy Circuit utility that is similar to the one on the ACS-UIT2. This can be used instead of the Edit >
Copy method in the menu bar.

Unassign Circuit - Clicking on this button will unassign the current circuit. This has the same effect as changing the Mode to Unassigned.

Temperature Control options - Once an application control mode is selected the temperature control method can be set to Ambient, Line
Sensing or PASC depending upon the application.
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3.2.2 TEMP VALUES TAB

Clicking this tab shows the data entry fields for all of the temperature parameters.

File Edit System Site Help
Circut 1D Mode General | Temp Values |RTDs | Alams | G.F. | Vottage | Maint. |
11 ID 11 Fipe Freeze Temperature Yaluss
g2 D Ehssasel) Martsin 40 °F  Deadband 5 °F
1-3 D 1-3 Unassigned
1-4 D14 Unassigned Economy T
1-5 ID1-5 Unassigned
24 D241 Unassigned Fail-Safe
22 D 2-2 Unassigned
2-3 D23 Unassigned
24 D24 Unassigned
25 D25 Unassigned
71 1D 7-1 Unassigned
TM-A  IDTM-A Temp Monitor
TM-B  IDTM-B Temp Monitor
TMLC  IDTMLC Temp Monitor
TM-D  IDTM-D Temp Monitor
TM-E IDTM-E Temp Monitor
[7] Hide Unassigned Circuits Add/Remove Devices

PCM Circuit1-1:1D1-1

Fig 7 Temp Values Tab

Maintain - The setpoint temperature of the circuit. This value can be changed in all Control Modes unless the Temperature Control is set to
PASC, where in this case it will be fixed at 40°F.

Economy - The economy temperature is the secondary setpoint temperature used in circuits who's Control Modes is set to HWAT, Floor
Heating or Greasy Waste. This input is only disabled if the previous case is true and the Setpoint Mode is set to Variable
(see below).

Deadband - The control temperature deadband of the circuit control.

Fail-Safe - The fail-safe mode is used if the control temperature can't be derived from the RTD inputs. If all control RTDs on a given circuit fails,
the relay state will be changed to what the fail-safe mode is set to.

Setpoint Mode - Setting this to constant automatically creates a schedule that is constantly using the Maintain temperature as the setpoint.
Changing this to variable will allow you to edit the schedule by clicking the Schedule button.

Schedule Button - Clicking on this button will launch the 24/7 Scheduler. See Section 3.2.8for more information on this utility.
PASC Parameters:

Min Ambient - The minimum design temperature for the piping application.

Min Pipe Size - The minimum pipe diameter for the application used to adjust the duty cycle time.

Power Adjust - Used to adjust the pipe maintain temperature for the application.
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3.2.3 RTDS TAB

Clicking this tab opens the RTD address and mode data input fields. Up to four RTDs can be assigned to the circuit. Depending on the

Temperature Control mode, RTDs can also be set as a controlling RTD or as a passive monitoring RTD.

When external control mode is selected the output of the snow controller is assigned in the RTD tab. Only one external control may be selected

for circuit.

Clicking on the X button clears the address and the number fields for the RTD.

Untitled xml - ACS-30 Program In

File Edit System

Site

Help

D
ID 11
D 1-2
D 1-3
D14
ID 1-5
ID 21
D 2-2
D23
D 24
25 ID 25
71 ID 71
TM-A  IDTM-A
TM-B  IDTM-B
ML IDTMLC
T™M-D  IDTM-D
TM-E IDTM-E

Mode

Pipe Freeze
Unassigned
Unassigned
Unassigned
Unassigned
Unassigned
Unassignad
Unassigned
Unassigned
Unassigned
Unassigned
Temp Monitor
Temp Monitor
Temp Monitor
Temp Monitor
Temp Monitor

| General | Temp Values | RTDs | Alams | G.F. | Vottage | Mairt. |

RTDs
Address Number Mode

RTDA [ ][ +|[LneControl -]
RTDB [ v][ | [Lne Control -]
RTDC [ =] | [tme Control -]
RTOD [ =]  ~|[Lne Control 7]

Hide Unassigned Circuits

PCM Circuit1-1: 1D 1-1

Figure 8 RTDs Tab
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3.2.4 ALARMS TAB

Clicking this tab displays the input fields for the temperature alarm values. It is only accessible if at least one RTD is directly measuring the
temperature of the pipe (either Line Control or Line Monitoring).

-

5

= Untitled.xml - ACS-30 Program Integrator

=B ®

|'\

File Edit System Site Help
Circuit 1D Mode
11 10 1-1 Pipe Freeze
1-2 D 1-2 Unassigned
1-3 1D 1-3 Unassigned
1-4 D14 Unassigned
15 ID 15 Unassigned
241 1D 2-1 Unassigned
2-2 D 2-2 Unassignad
23 D23 Unassigned
24 D24 Unassigned
25 D25 Unassigned
71 1D 71 Unassigned
TM-A 1D TM-A Temp Monitor
TM-B  ID TM-B Temp Monitor
TMLC  IDTML Temp Monitor
TM-D IDTM-D Temp Monitor
TM-E IDTM-E Temp Monitor

| General | Temp Values | RTDs | Alams |G.F. | Voltage | Maint, |

Aam Values
Low Temp 331

Mam Fitter 1% Min

High Temperature Cutout
High Temp Cutout

High Temp 140 °F

150 °F

Enabled

[7] Hide Unassigned Circuits

Add/Remove Devices

PCM Circuit1-1: 1D 1-1

Figure 9 Alarms Tab

Low Temp - An alarm condition will occur if the line RTD is below this value.

High Temp - An alarm condition will occur if the line RTD is above this value.

Alarm Filter - The time an alarm condition must constantly be in before an actual alarm occurs.

High Temp Cutout - If any line RTD exceeds this value, the heating cable for that circuit will automatically turn off. If the temperature falls
below this value again, the heating cable will turn back on.

High Temp Cutout Enabled - Indicates if High Temp Cutout is enabled.

RAYCHEM-AR-H58325-ACS30programintegrator-EN-2504
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3.2.5 GROUND FAULT TAB

This window provides windows to set levels for ground-fault alarm and trip.

-

5

= Untitled.xml - ACS-30 Program Integrator

lo|E| =

|w

File Edit System Site Help
Circut 1D Mode
11 ID 11 Fipe Freeze
1-2 D 1-2 Unassigned
1-3 D 1-3 Unassigned
1-4 D14 Unassigned
1-5 ID1-5 Unassigned
241 1D 2-1 Unassigned
22 D22 Unassigned
2-3 D23 Unassigned
24 D24 Unassigned
25 D25 Unassigned
71 1D 7-1 Unassigned
TM-A  IDTM-A Temp Monitor
TM-B  IDTM-B Temp Monitor
TMLC  IDTMLC Temp Monitor
TM-D  IDTM-D Temp Monitor
TM-E IDTM-E Temp Monitor

| General | Temp Values | RTDs | Alams | G.F. | Voltage | Maint, |

Ground Fautt
GF Alam 20

mA

GF Trip

30 mA

[7] Hide Unassigned Circuits

Add/Remove Devices

PCM Circuit1-1:1D1-1

Figure 10 Ground Fault Tab

GF Alarm - An alarm condition will occur if the ground fault reading exceeds this value.

GF Trip - An alarm condition will occur and the heating cable will turn off if the ground fault reading exceeds this value.
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3.2.6 VOLTAGE TAB

This window provides a window to enter the system voltage used to monitor the energy used by the circuit. Supply voltages from

120 to 277 V used are with the standard ACS-PCM2-5 panels. Custom panels are required for 480 V and 600 V.

Untitled xml - ACS-30 Program I

T

File Edit System Site Help
Circut 1D Mode | General | Temp Values | RTDs | Alams | G.F. | Votage | Maint,
11 10 1-1 Pipe Freeze Voltage
12 D12 Unassigned Voltage m
1-3 1D 1-3 Unassigned 120V
14 D14 Unassigned 208V
15 ID 1-5 Unassigned 240V
21 D2 Urisssiaricd ﬂ —
22 D 2-2 Unassigned |GV (Custom)
23 D23 Unassigned 480V 38 (Custom)
24 D24 Unassigred 600V 3@ (Custom)
25 D25 Unassigned
71 1D 71 Unassigned
TM-A 1D TM-A Temp Monitor
TM-B  ID TM-B Temp Monitor
TMLC  IDTML Temp Monitor
TM-D IDTM-D Temp Monitor
TM-E IDTM-E Temp Monitor

Add/Remove Devices

Hide Unassigned Circuits

PCM Circuit1-1: 1D 1-1

Figure 11 Voltage Tab
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3.2.7 MAINTENANCE TAB

This window allows you to engage the "Power Cycle Test" at a specified time and interval. This feature powers a circuit for two minutes to
ensure it is operational.

T

Untitled xml - ACS-30 Program I

File Edit System Site Help
Circut 1D Mode | General | Temp Values | RTDs | Aams [ G.F. | Votage| Maint. |
11 10 1-1 Pipe Freeze Mairtenance
::'i :B ::'; 3"35519": Power Cycle Start Time ~ 6:01 = 24Hr
- - nassign
4 D14 Unassigned Power Cycle Interval
15 ID 1-5 Unassigned
241 1D 2-1 Unassigned
22 ID 22 Unassigned
23 D23 Unassigned
24 D24 Unassigned
25 D25 Unassigned
71 1D 71 Unassigned
TM-A 1D TM-A Temp Monitor
TM-B  ID TM-B Temp Monitor
TMLC  IDTML Temp Monitor
TM-D IDTM-D Temp Monitor
TM-E IDTM-E Temp Monitor
Hide Unassigned Circuits Add/Remove Devices

PCM Circuit1-1: 1D 1-1

Figure 12 Maint. Tab
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3.2.8 THE 24/7 SCHEDULER

The 24/7 Scheduler is used to program variable temperature setpoints at specific times during the week for HWAT, Freezer Frost Heave (with
ACS-UIT2), Floor Heating and Greasy Waste heating applications. The 24/7 Scheduler has the following setpoints:

+ Maintain: The main design temperature for an application
+ Economy: A set back temperature for energy savings.
+ Off: Used to save additional energy
Heat Cycle: Used to rapidly increase pipe temperatures (only for HWAT-R2 heating cables).

E—
Monday

Econ

off

012345678 91011121314151617 18192021 2223 24
&mﬂhw|MMﬂ

From |[12:00 AM

Ta I'IZ:EDAI'H'I "’I e |
Mode | Mairtain - .HE.I

Figure 13 Main 24/7 Scheduler Window

Scheduler Graph - The schedule is represented by a colored bar graph. The time of day is labeled across the bottom in 24 hour format
starting at O (12:00am) and ending at 24 (12:00am). Each intermediate tick mark represents a half-hour in time. Each temperature setpoint is
represented by both the height and color of the bar. The mode colors are described below:

Maintain: Orange

Economy: Green

Off: Blue

Heat-Cycle: Red (HWAT-R2 only)

The main screen of the Scheduler displays all of the data input fields needed to create a schedule. All of the functions are
described below.
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3.2.9 GENERAL TAB

The General tab allows you to create a schedule to match the weekly use pattern of the heating application.
General I Copy | Presets|
From |12:00 AM "I
Add I Change Day
To I12:30 AM "I
I < | 5 | Save I
Mode IMaintain 'I

Figure 14 General Tab

Scheduler Dropdown Boxes - The dropdown boxes labeled “From”, “To", and "Mode" are used to configure the schedule. A more detailed
procedure on how to do this is described in the Section 3.2.6.4.

Add Button - The add button deciphers what is configured in the Scheduler dropdown boxes and places it into the schedule. See Section
3.2.6.4 below for more information.

Clear Button - Clicking on this button will clear the entire schedule. This will set every day of the week to act in Maintain mode. This would be
synonymous to setting the Setpoint Mode to Constant.

Change Day Buttons - Pressing the < button will navigate you to the day prior to the one that is currently being displayed. Conversely,
pressing the > Button will advance you to the next day.

Save Button - Saves the changes on the current schedule.

Close Button - Exits the Scheduler. If the schedule changed and was not saved, the Scheduler will prompt you asking if you want to save the
changes that were made before exiting.

3.2.10 COPY TAB

This tab allows you to copy the current day being displayed to any other day(s) in the schedule. To do this, place a check mark next to each day
that you wish to copy to and press the Copy button.

Gereral Copy |F'rese‘ts|

Copy dayto... [T Monday ™ Fiday
[T Tuesday [T Saturday
[T Wednesday [T Sunday

Uncheck All | [T Thursday [ Al Copy

Figure 15 Copy Tab

To cancel at any time, click on the General tab and click the Close button.
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3.2.11 PRESETS TAB

When using the Scheduler for an HWAT circuit, the presets option will appear on the main screen. Clicking on this tab will bring you to the
presets configuration screen where you can choose out of a list of common presets. After choosing a preset, they can be modified to fit your
specific needs.

x

Apartments - Monday

Maint

¢ 1 23 45678 91EI1112131415151?18192021222324

General I Copy F'I'ESE‘tS
Change Day

I;'l'-.partmerds j 5 .

Apply

Figure 16 Presets Window

Presets Dropdown Box - Click on the drop down box to view the list of presets available. Selecting a preset will temporarily display it on the
Scheduler Graph.

OK Button - Clicking on the OK button will prompt you asking if you would like to overwrite the original schedule with the new preset
schedule. After a decision is made, you will be brought back to the main General tab.

Change Day Buttons - As with the General tab, clicking on these buttons will navigate you throughout the week.
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3.2.12 CONFIGURING A SCHEDULE

A schedule can be configured into 48 discrete 30-minute intervals per a 7-day week where each day can be unique.

To schedule a block of time to a specific mode:

1. Select the start time from the “From” drop-down menu.
ID 1-1 - Scheduler x|

Econ

Off
0123456 7 8 9101112131415 16 17 18 19 20 21 22 23 24

From |3:30 AM w7

|

To [6:30 AM

Hode 0 A
830 AM

L AR

Figure 17 Selecting Start Time

2. Select the end time from the “To"” drop-down menu.
011 -scheduier
Monday

Maint}-

Econ —

off

0123456 7 8 9101112131415 1617 18 152021222324
General | Copy | Presets |

From IS:DOAM 'I .
To |6:30 AM ¥
| o | <[ | —==
Mode [12:30 PM ~ Close
1230 P} [ Gee ]
1:30 PM
Figure 18 Selecting End Time
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3. Select the mode from the “Mode” drop-down menu.

Monday

Econ

Off

012 3456 7 8 9101112131415161718 192021222324

From | 5:00 AM hi
Add Change Day
A |
o [12:00 PM om | . | . | Save
Mode |Mairtain - .EE.I

ID 1-1 - Scheduler |

:l Economy

Figure 19 Selecting Setpoint Mode
4. Tap on the "Add" button.

011 scheder
Monday
Mai

Econ

off

0123456 7 8 9101112131415 16 17 18 19 20 21 22 23 24
EMﬂ&m|maﬂ

From |12:00 PM 7
Ta |12:3'I] FM TI

e S
S ow |
Mode | CHf hd

Save |
_ Cose |

Figure 20 Time Segment Added to Graph

5. Repeat as necessary
6. Click Save
7. Click Close
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SECTION 4 - PRINTING CIRCUIT SUMMARY

Once the ACS-30 system circuit database has been created, a summary of the database can be printed for site records and to assist in the
heating cable commissioning. The printout is divided into several sections:

Job Site: The job site name, address and contact information can be entered when you click the SITE main menu bar.

Device List: Summarizes all devices added to the system.

Circuit List Summary: Lists all circuits with circuit number, circuit ID, Control mode, and assigned RTDs.

Individual Circuit Parameter List: Lists all control parameters for each circuit.

Raychem

RAYCHEM ACS-30 Program Integrator

Manual test screens.xml - Page 1 of 20

Site Documentation

Site Name: ACS-30 Demonstration Building

Address:
Phone:
Site Supervisor:

Date: 3/18/2013

Notes:
Device List
1 PCM 1,2,3,4,5 1,4
2 PCM 1,2 1,2,3
7 910 1 1,2
32 RMM2 N/A None
Stagger Start
Stagger Start: 5 Minutes

Figure 21 Examp

RAYCHEM-AR-H58325

le Print-Out

-ACS30programintegrator-EN-2504
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Raychem

RAYCHEM ACS-30 Program Integrator

Manual test screens.xml -

Page 2 of 20

Circuit List Summary
1-1
1-2
1-3
1-4
1-5
2-1
2-2
2-3
2-4
2-5
7-1
T™M-A
T™-B
TM-C
T™M-D
TM-E

Cooling tower 1
Cooling tower 2
Cooling tower 3
Hot water west wing
Hot water east wing
Lobby Floor

Lobby Floor 2

Floor override

D 2-4

ID 2-5

Fire Sprinkers

ID TM-A

ID TM-B

ID TM-C

ID TM-C

ID TM-E

Control Mode

Pipe Freeze
Pipe Freeze
Pipe Freeze
HWAT

HWAT

Floor Heating
Floor Heating
Unassigned
Unassigned
Unassigned
Pipe Freeze
Temp Monitor
Temp Monitor
Temp Monitor
Temp Monitor

Temp Monitor

Assigned RTDs/EXTs

1-1

None
None

1-4

None
2-1,2-2,2-3
2-2,2-1,2-3e
2-3

None
None
71,72
None
None
None
None

None

Figure 22 Example Print-Out

RAYCHEM-AR-H58325-ACS30programintegrator-EN-2504

chemelex.com | 29



Raychem

RAYCHEM ACS-30 Program Integrator

Manual test screens.xml - Page 3 of 20

Circuit 1-1: Cooling tower 1
General

Device Address: 1

Relay Number: 1

Circuit Control: Enabled
Control Mode: Pipe Freeze

Fail-Safe: Power On

Temperature Values

Maintain: 40°F

Deadband: 5° F

RTDs

RTD A: 1-1 (Line Control)

RTD B:

RTD C:

RTD D:

Alarm Values

Low Temperature: 33° F

High Temperature: 140°F
Temperature Filter: 15 Minutes
High Temperature Cutout Enabled
Ground Fault

Ground Fault Alarm: 20mA
Ground Fault Trip: 30mA
Voltage

Voltage: 208V

Power Cycle Test

Power Cycle Time: 6:01

Interval: Weekly

Temperature Control Mode: Line Control

Figure 23 Example Print-Out
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SECTION 5 - TRANSFERRING THE DATABASE USING A USB FLASH DRIVE

The ACS-UIT2 is programmed to automatically detect and read a USB flash drive when inserted. To download the XML circuit database file to
the ACS-UIT2 using the USB Flash Drive:

1. Save the XML file to a USB flash drive.
2. Insert the USB flash drive into the left side of the ACS-UIT2 as shown in the figure below.

CAN
(not used)

/N

RS-4B5
[not used)

Side view

Figure 24 USB port on ACS-UIT2.

The following screen will appear on the ACS-UIT2, click “Select XML database”

Update ACS-UIT from USB Drive

Figure 25 USB Utility Screen
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Locate the XML file in the flash drive and tap on the OK button.

open 1] ] [EE

3 “Hard Disk
3 ACS_UITZ DEMO1
£ ACS-UIT Exarple
' Prograrm Integrator Polar 11
' Setup
IACS training

Marne: |&C5 training Type: | XML File

Figure 26 Selecting an XML file

Click OK to overwrite the current database installed on the UIT2.

5.1 5.1 Uploading the circuit database to a USB flash drive

The ACS-UIT2 is programmed to automatically detect and read a USB flash drive when inserted. To upload the XML circuit database file to the

ACS-UIT2 using the USB Flash Drive:

1. Insert a USB flash drive in the UIT2 as detailed in figure 5.1.
2. Tap the "Backup database files to USB Drive" button.

3. To edit this XML file, go to File>open. Locate the XML file in the flash drive and tap on the OK button.
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SECTION 6 - IMPORTING AND EXPORTING DATABASES

The main function of this tool is to transmit and receive databases to and from an ACS-UIT2, allowing for easy creation and management of a
commercial heat-tracing system. This utility can be accessed by clicking on File > Import and Export.

Once a database has been created, this tool can easily transfer the data to the UIT2. Alternatively, if a database from the UIT2 needs to be
backed up or edited, this utility can so retrieve information from the UIT2.

Modbus Address Import/Export Database
@ Exportto ACS-UIT
(™) Import from ACS-UIT

Port

Baud Rate vl

P Address

Database File

Figure 27 Import/Export Window

Exporting and Importing a Database
1. Select the Modbus® address of the ACS-UIT2 in the Modbus Address drop down menu.

2. Select the desired port to use.

3. If aserial port was selected, select a Baud Rate. This must match the Baud Rate set on the ACS-UIT2 (System | Comm).
If TCP/IP was selected as the port, enter the UIT2's IP address, located in System|Comm of the UIT2.

4. Select the database file to either save to or send from.
5. After clicking OK, a status window will give you the status of the database transfer.

Refer to the ACS-UIT2 Installation Instructions (H58239) for further details on connections and input parameters.
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Using RS-232 Connection

The RS-232 port can be used as a direct connection to a single PC located within 15 meters (50 feet) of the panel. For an RS-232 connection, a
3-foot long RJ11 to 9-pin female D-connector is provided with the ACS-UIT2. Plug the RJ11 connector into the RS-232 connector on the ACS-UIT2
and the other end into the 9-pin male connector on the user’s computer.

Il

o}

uoneujwIa ]
1-68%-5Y
B B

I{" ]}

2-587-Sy
*
: Gr .
¥

ZI:Z-SQ
{I@;ﬁ‘ g
uoneulwa]

o
®

1 R

Side view 3-foot RJ11 to
9-pin female D connector

Figure 28 Connection via RS-232
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Using RS-485 Connection

Use the RS-485 port when multiple ACS-UIT2 units are to be connected to a host computer or the connection is longer than 15 meters
(50 feet). An RS-485 to RS-232 converter may be required to make the connection to the user's PC.

TE3
Qo0
415|6
QI '-’.P
E
d- D
1|+
L |
i
(7l ]
[ [
dd
i |
R5-485 ]
GConverier
8-pin
female
—
PC Laptop or 8-pin
BMS Interface male

Figure 29 Connecting via RS-485

Using Ethernet Connection

Connect an Ethernet cable from the ACS-UIT2 to a Network node.

USB device port
Open Collector Outputs [not used) Network node

i ' it O3
g ._:}\Q(’ ) D‘ Elhamel ’ k EI -1\\ @
RS-485-2  RS-485-1 Ethernet cable % » @

< ,;@‘é,:: Debug Port (not used)

I

Bottom view

Figure 30 Connecting via Ethernet
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Configuring the ACS-UIT2

The ACS-UIT2 must be configured properly to Import and Export XML files. On the UIT2 itself, go to System|Comm screen on the ACS-UIT2 to

configure these settings.

Main |Setup |Status |Events |Network |System

192.168.1.101
235.255.255.0

thernet

Misc (Relays|Comm [Clock [Password |Maint.

Figure 31 System|Comm Screen

Using RS-232: Change Serial Port Mode on the UIT2 to RS-232 and make sure Read/Write Port is set to Serial.
Using RS-485: Change Serial Port Mode on the UIT2 to RS-485 and make sure Read/Write Port is set to Serial.

Using TCP/IP: Set Read/Write Port to Ethernet and disregard Serial Port Mode on the UIT2.

This screen on the UIT2 will also display the information needed for the Program Integrator
(Modbus Address, Baud Rate and IP Address).

North America Latin America Europe, Middle East, Africa, India
Tel +1800 5456258 Tel +1713 868 4800 Tel +3216213 5N
info@chemelex.com info@chemelex.com Fax +3216 213 604

info@chemelex.com

Asia Pacific

Tel +862124121688
infoAPAC@chemelex.com

ChemEIEX Raychem Tracer Pyrotenax Nuheat

excellence is everything

©2025 Chemelex. All Chemelex marks and logos are owned or licensed by Chemelex Europe GmbH or its affiliates. All other
trademarks are the property of their respective owners. Chemelex reserves the right to change specifications without notice.
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